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Copyright

©Copyright 2019 Honeywell International Inc. All rights reserved. Honeywell and its product
names are among the trademarks and/or service marks owned by Honeywell International, Inc., or
its subsidiaries.

Vocollect Voice Solutions

703 Rodi Road

Pittsburgh, PA 15235

+1 412 829-8145

fax +1 412 829-0972
http://www.honeywellaidc.com

Honeywell International Inc. (“HII”) reserves the right to make changes in specifications and other
information contained in this document without prior notice, and the reader should in all cases
consult HIl to determine whether any such changes have been made.

The information in this publication does not represent a commitment on the part of HIl. HIl shall
not be liable for technical or editorial errors or omissions contained herein; nor for incidental or
consequential damages resulting from the furnishing, performance, or use of this material.

This document contains proprietary information that is protected by copyright. All rights are
reserved.

No part of this document may be photocopied, reproduced, or translated into another language
without the prior written consent of HIl.

New Features in VoiceArtisan 2.1

Signed jar Files
For this release, all new plugins added to the update site are provided as signed jar files.

[=] Note: To use version 2.1 of VoiceArtisan, you will need a new 2.1 license.



System Requirements for the VoiceArtisan Bundle

Operating Systems

« Windows 7 Professional 64-bit
e Windows 10 Professional 64-bit

Hardware

To test a voice application on your computer, you will need a Vocollect wired headset.

We recommend you use a CMedia CM108 USB Virtual 7.1 Channel Sound Adapter for your head-
set. This adapter has been tested by Honeywell and is recommended for testing applications
through VoiceCatalyst Emulator.

Software

Eclipse version 4.7.3a

provided in zip file

PyDev 6.2.0

provided in zip file

Java version 8 or higher

not provided--you must supply

must be a 64-bit version to be compatible with Eclipse



Installing the VoiceArtisan Plugin Independently

The bundle provided by Vocollect is the tested and supported version of VoiceArtisan. It is pos-
sible to install the VoiceArtisan and library plugins to an alternate Eclipse environment provided
minimum criteria are met. Support and troubleshooting for environments other than the bundled
zip will be limited.

o Eclipse minimum version 4.7.3a
« Java version required by the specific Eclipse version chosen
« PyDev exact version 6.2.0

« This exact requirement is due to VoiceArtisan needing to tie into non-public
PyDev API calls which are not guaranteed to be consistent in future versions.

Installing the VoiceArtisan Plugin

1. Unzip orinstall Eclipse, currently at https://www.eclipse.org/

2. Install the Java version required by Eclipse.
3. Add the PyDev 6.2.0 update site under Help > Install New Software > Add.

a. Currently listed at http://www.pydev.org/ as http://www.pydev.org/update_
sites/6.2.0

b. If the update site is available, the VoiceArtisan plugin will automatically
install PyDev during the VoiceArtisan installation.

c. If the update site is taken down in the future, you may need to obtain the
PyDev 6.2.0 drop-in files. See eclipse.org for information on how to deploy
the drop-in.

d. If neither the update site nor the drop-in is available in the future, use the
official bundle containing the prerequisite PyDev 6.2.0.

4. Add the VoiceArtisan Update site under Help > Install New Software > Add. This is loc-
ated at Vocollect Voice Updates - https://s3.amazonaws.com/update-site-2/.

5. Working with the Vocollect Voice Updates site, install the Vocollect VoiceArtisan plugin.

a. This is currently unsigned content, click Install anyway to proceed with
installation.

b. Restart.
6. Import a valid license under Window > Preferences > VoiceArtisan > License.

Install any examples, libraries, Voice Applications, and VoiceCatalyst Emulators* from
the Vocollect Voice Updates site

Note:

The current VoiceCatalyst Emulators, versions 1.0.0 through 2.3.1, which include
both the Python environment and an executable to run a project as a VoiceCatalyst
Application, are only available for Windows environments. This prevents the ability
to run anything that requires the voice APl or mock_catalyst module (which itself
depends on the voice API in order to override it) on other operating systems.


https://www.eclipse.org/
http://www.pydev.org/
http://www.pydev.org/update_sites/6.2.0
http://www.pydev.org/update_sites/6.2.0
https://s3.amazonaws.com/update-site-2/

It may be possible to run a MockCatalyst test file in the console, but not a project as a VoiceCata-
lyst Application, on other Operating Systems by:

1. Installing a general Python 3.1.2 and/or Python 3.6.6 installation, currently at
https://www.python.org/

2. Configuring the Python installation for PyDev 6.2.0 in Eclipse under Window > Prefer-
ences > PyDev > Interpreters > Python Interpreters > New.

3. From a Windows installation of VoiceCatalyst Emulator, copy:

o The stubbed contents of voice.py and its subpackages, under VCE > vce/Vo-
collectVoice/Lib, when used by a VoiceArtisan VoiceApplication in the Project
Explorer View.

« mock_catalyst.py from VCE > System Libs.

4. Create a new netadapters.py implementing a get adapters function returning an
empty dictionary.

This is a compiled extension created by Vocollect, used in the HTTP Library udp-
broadcast.py.


https://www.python.org/

General Considerations and Limitations

General VoiceArtisan IDE Limitations

Do Not Add Update Site to Earlier VoiceArtisan Instances

Do not add the new update site to an existing VoiceArtisan 1.x Eclipse
environment. Dependency issues will result and you may be unable to
install plugins from the old update site.

VoiceCatalyst on Device Not Supported with A700x

Running VoiceCatalyst on Device is not supported with the A700x.

Viewing Error Markers

A new setting in Eclipse for PyDev causes error markers to not show when
the file containing the error is closed. To have the error markers appear
even when the file is closed:

From the Window menu, select Preferences.

N

Select PyDev.
3. Select Builders.

4. Deactivate the Remove errors when editor is closed check box.

Python Debugger Not Stopping at Break Points

On occasion, the Python debugger will not stop at break points. If this
occurs, right-click the project you are running and select Pydev... >
Remove *.pyc, *.pyo and *$py.class files. This will ensure that during the
next run, .pyc files are recreated with the appropriate break points.

License Warning Does Not Appear

If your license is nearing expiration and you start Eclipse and a VoiceAr-
tisan-specific view does not have focus, you will not receive a warning
that the license is about to expire. The message will only appear when you
open a VoiceArtisan view or VoiceArtisan preferences.

RBIRD-220

Cannot Edit File Added to Project

If you are using a source control system and have your voice application
projects under team management in Eclipse, if you add a file to the pro-
ject, you cannot edit that file. To edit the file, you must either add it to
source control or change the file properties to remove the read only
status.

RBIRD-178

Prompt to Save When Switching Between Run Configurations

If you open an existing run configuration and click on the Device Prop-
erties or Project Properties tab without changing anything in those tabs,
then click on a different run configuration, you will be prompted to save
due to unsaved changes. Dismiss the message dialog box by clicking one
of the buttons.

RBIRD-232

Install Microsoft Language Packs




Note that if you are using a TTS in an Asian, East Asian or any right-to-
left language, you must install the appropriate Microsoft language pack
in order to properly view the characters.




Security Considerations

Developers should be aware of the following known security vulnerabilities in Python version 3.1.2
distributed as part of the VoiceCatalyst Emulators 1.0.0 through 2.3.1 for VoiceArtisan.

Known Python Vulnerabilities

Issue Summary Discussion

Component xmlsec-java | The (1) BasicParserPool, (2) Stat-
version 1.4.0 was detec- | icBasicParserPool, (3) XML Decrypter, and (4)

ted in com.- SAML Decrypter in Shibboleth OpenSAML-

VARTSEC-38 vocollect.voiceartisan_ | Java before 2.6.1 set the expandEntityRe-
2.1.0.201908230755.jar | ferences property to true, which allows remote
has 1 vulnerability. attackers to conduct XML external entity

(XXE) attacks via a crafted XML DOCTYPE

Simultaneous login ses-
sion for single user is
allowed in an applic-
ation.

VARTSEC-43

It is observed that file
upload functionality in
the application is not
validating for mal-
ware/virus being
uploaded. It is recom-
VARTSEC-39 mended to perform vir-
us/malware scan when
a file is being uploaded
or else the target sys-
tem/environment could
get infected with mal-
ware.

It is observed that
application is not val-
idating files in side the
compressed folder.
Intruder can compress
VARTSEC-40 any type of file format
(php, exe, jar...) and
upload.

It is recommended to verify the file size and
type of file within compressed folder.

Upload functionality is
also not verifying the



https://nvd.nist.gov/vuln/detail/CVE-2013-6440

Issue

Summary

Discussion

size of file before being
uploaded. The file space
of the Web server could
be exhausted by the
attacker uploading a
huge file. Tested with
2GB file.

VARTSEC-32

It has been observed
that MD5 hashing
algorithm is used in the
libraries. PFA POC

VARTSEC-36

Component opensaml-
java version 1.1 was
detected in com.-
vocollect.voiceartisan_
2.1.0.201908230755.jar
has 1 vulnerability.

CVE: CVE-2013-4517

Apache Santuario XML Security for Java
before 1.5.6, when applying Transforms,
allows remote attackers to cause a denial of
service (memory consumption) via crafted
Document Type Definitions (DTDs), related to
signatures.

VARTSEC-42

It is observed that there
is no server-side val-
idation implemented for
verifying input to create
rules. It is possible to
bypass client-side val-
idation using proxy and
enter random characters
of no length restrictions.

Application is not val-
idating the length and
special characters of the
input.

VARTSEC-44

It is observed that
Secure Flag is missing
in the cookie

When a cookie is set with the Secure flag, it
instructs the browser that the cookie can only
be accessed over secure SSL/TLS channels.

This is an important security protection for
session cookies.

VARTSEC-26

It has been observed
that VoiceArtisan lib-
raries HTTP, LUT/ODR
makes use of ports



https://nvd.nist.gov/vuln/detail/CVE-2013-4517

Issue Summary Discussion
80,9001,15008,150009 .
When the voice applic-
ation runs on the Talk-
man device, it will open
the respective ports for
communication. Com-
munication over these
ports is not on secure
channel.
It has been observed
that web url used to pull
VARTSEC-25 the plugins from the
cloud server is running
over HTTP. PFA. POC
An http parameter over {VoiceAr-
tisan<=>WarehouseManagementSys:HTTP}
Validate URl inputs for | 1,5y contain a URL value and could cause the
injected URLs or [VoiceArtisan] to redirect the request to the
attempt to use the URL | gpecified URL. By modifying the URL value to
VARTSEC-22 to directly affect assets. | 3 malicious site, an attacker may successfully
Error output ShOL_‘ld Not | launch a phishing scam and steal user cre-
contain information use- | yentials. Because the server name in the mod-
ful to attackers. ified link is identical to the original site,
phishing attempts have a more trustworthy
appearance.
Store Salted Hashed credential (PBKDF2,
bcrypt) or encrypt private keys. If possible use
Use strong password LDAP like technologies for storage. Have an
policy, secure channels | account per user and associated process.
used in authentication. | Assure that authentication channel is secure,
Pass- i.e.: local connection, SSH, VPN, or TLS. Imple-
VARTSEC-9 word/Authentication ment a credential update policy i.e, change
Policy and Man- default PW, minimal length and mix of chars,
agement. Limit number | change often, don’t save PW in the clear. Docu-
of sessions a single user | ment the password management con-
is allowed. figuration for the (preferably automatic)
installation and the recommended settings in
the Security Manual.
Protect network con- L .
nections from DoS; pre- Rat'e limit connections and data transfers to
VARTSEC-21 {VoiceAr-

vent resources from
being consumed; a plan

tisan<=>WarehouseManagementSys:HTTP}




Issue Summary Discussion
(if possible). Prevent the users of the [VoiceAr-
tisan] from exhausting storage space,
to recover from crashed | memory, network ports, processes or other
systems as quickly as resources. The Security Manual must specify
possible; system failures | backup, recovery, etc. policies and planning.
fail safe. Any DOS failure, especially a 'hung’ system
should fail safe and not allow damage to
people or equipment.
Log access to {VoiceArtisan}
Protection of audit and other requests to assets, especially failed
VARTSEC-20 information, time attempts to access any asset. Assure suf-

stamps, non-repudiation
in logs.

ficient storage, indicate when near full or
wrapped, programmatic access and centrally
manage if possible

Issue #11662: Redir-
ect vulnerability in
urllib/ urllib2. Bug

report http://bug-

s.python.org/
issuell662

The urllib and urllib2
modules in Python 2.x
before 2.7.2 and 3.x
before 3.2.1 process
Location headers that
specify redirection to
file: URLs, which makes
it easier for remote
attackers to obtain sens-
itive information or
cause a denial of service
(resource consumption)
via a crafted URL, as
demonstrated by the
file:///etc/passwd and
file:///dev/zero URLs.

« The bug could disclose sensitive
information in the following scen-
ario: In your Python program, sup-
pose you are using the urllib
module to retrieve a web page from
a remote server and display it to
the user of your program. Suppose
that the remote server, instead of
returning a web page to you, sends
a redirect 302 HTTP response, and
it redirects you to a local file in
your environment. If that file con-
tains sensitive information and you
display it, the user of your program
could see the sensitive information.

« Notice, however, that nobody at the
remote site (potentially outside the
trust zone) can see the information,
just the user of your program. For
VoiceCatalyst, that would be the
user of the mobile device with an
attached display of some kind. For
VoiceArtisan, it would only be the
application developer.

« In either case, the "attacker" or the
recipient of the sensitive inform-
ation would be an insider (either
the developer of the app or a



http://bugs.python.org/issue11662
http://bugs.python.org/issue11662
http://bugs.python.org/issue11662

Issue

Summary

Discussion

mobile worker). Thus this is a
highly unlikely and low-risk scen-
ario, in addition to the fact that our
device does not contain sensitive
information files.

Issue #13703: Hash
collision security
issue. Bug report:

http://bug-

s.python.org/
issuel3703

Python before 2.6.8,
2.7.x before 2.7.3, 3.x
before 3.1.5, and 3.2.x
before

3.2.3 computes hash val
ues without restricting
the ability to trigger
hash collisions pre-
dictably, which allows
context- dependent
attackers to cause a
denial of service (CPU
consumption) via craf-
ted input to an applic-
ation that maintains a
hash table.

« Hash collisions can be exploited
via denial of service attacks in web
frameworks that automatically
parse input forms into dictionaries.

o As you can see in the discussion of
the bug at the specified link, it is
quite obscure and difficult to
exploit.

o Itis unlikely that an attacker would
bother to attack a Talkman device,
but it is easily preventable by run-
ning devices on a security- enabled
Wi-Fi network so the built in web
server on the device is not access-
ible outside of your security realm.

Issue #14579: Vul-
nerability in the utf-
16 decoder

after error handling.

The utf-16 decoder in
Python 3.1 through 3.3
does not update the
aligned end variable
after calling the uni-
code decode call
errorhandler func-
tion, which allows

The bug is easily avoidable by using utf-8
encoding/ decoding in your application. It is
the encoding we recommend and you can

Bug report: remote attackers to . .
http://bug- obtain sensitive inform- encode any localized text using utf-8.
s.python.org/ ation (process memory)
issuel4579 or cause a denial of ser-
vice (memory corruption
and crash) via unspe-
cified vectors.
Issue #20246: Buffer overflow in the In order to be attacked by the bug, an applic-

Buffer overflow in

socket.recvfrom_into.

Bug report:

http://bug-
s.python.org/

socket.recvfrom
into function in Mod-
ules/ socketmodule.c in
Python

2.5 before 2.7.7, 3.x

ation running on the mobile device would
have to be opening a raw listen socket and
not an HTTP port. None of our library or
example applications do this.

If you need to create such an application, if



http://bugs.python.org/issue13703
http://bugs.python.org/issue13703
http://bugs.python.org/issue13703
http://bugs.python.org/issue14579
http://bugs.python.org/issue14579
http://bugs.python.org/issue14579
http://bugs.python.org/issue14579
http://bugs.python.org/issue20246
http://bugs.python.org/issue20246
http://bugs.python.org/issue20246

Issue Summary Discussion

before 3.3.4, and 3.4.x

before 3.4rcl allows you run your devices in a secure Wi-Fi envir-
issue20246 remote attackers to onment, no clients outside the security zone

via a crafted string.

execute arbitrary code would be able to exploit the weakness.

Known VoiceArtisan IDE Vulnerabilities

Issue Summary Discussion

Component xmlsec-java ver- The (1) BasicParserPool, (2) Stat-

sion 1.4.0 was detected in icBasicParserPool, (3) XML Decrypter, and (4)
VARTSEC- | com.- vocollect.voiceartisan_ SAML Decrypter in Shibboleth OpenSAML-Java
38 2.1.0.201908230755.jar has 1 before 2.6.1 set the expandEntityReferences prop-

vulnerability. erty to true, which allows remote attackers to con-

duct XML external entity (XXE) attacks via a

CVE: CVE-2013-6440 crafted XML DOCTYPE declaration.

Component opensaml-java ver-

sion 1.1 was detected in com.- | Apache Santuario XML Security for Java before
VARTSEC- | vocollect.voiceartisan_ 1.5.6, when applying Transforms, allows remote
36 2.1.0.201908230755jar has 1 attackers to cause a denial of service (memory

vulnerability. consumption) via crafted Document Type Defin-

itions (DTDs), related to signatures.

CVE: CVE-2013-4517

Protection of audit information,

time stamps, non-repudiation

in logs Detail

Log access to {VoiceArtisan}
VARTSEC- | and other requests to assets,
20 especially failed attempts to

access any asset. Assure suf-

ficient storage, indicate when

near full or wrapped, pro-

grammatic access and cent-

rally manage if possible.



http://bugs.python.org/issue20246
https://nvd.nist.gov/vuln/detail/CVE-2013-6440
https://nvd.nist.gov/vuln/detail/CVE-2013-4517

Previous Release Notes

New Features in VoiceArtisan 2.0

Data Collection Support

This release of VoiceArtisan includes support for data collection. This allows you to create tasks
that send data that you choose to Honeywell, where it can be used to generate reports and
insights.

Support for A700x Devices

This release of VoiceArtisan includes support for the latest Vocollect devices, the A700x series.

[=] Note: To use version 2.0 of VoiceArtisan, you will need a new 2.0 license.
New Features in VoiceArtisan 1.3.2

Response Expressions Enhancements

This release includes enhancements that update the response expressions:
« when the recognizer is still waiting for the operator response
« when the operator speaks through a phrase without pausing

« when the operator speaks part of a phrase and pauses before finishing
Updating response expressions during these times allows for the recognizer to better adapt to an
operators speech patterns and reduce insertions. See About Response Expressions for more
information.

You can now use wildcard characters in response expressions to be used for adaptation, thereby
eliminating the need to specify every combination of words that can be spoken. Now a developer
can use an asterisk (*) to match a single vocabulary item. Each asterisk must match exactly one
recognized one vocabulary item to be considered a match. For example, if the user can say any
alpha after a three digit check digit (for example, for a tote ID), the hint may be specified as
"123*". Wildcards can be specified in any position in the utterance, and there is no limit on the
number allowed.

Important: Because of this feature, you can no longer use an asterisk as a vocabulary item.

For more information, see Using Response Expressions in the online help.

Define Recognizer Sensitivity By Word

You now have the ability to adjust the sensitivity of specific vocabulary words by setting the para-
meter BlueStreak_Decode_Sensitivity_<word>=<threshold>. This enhancement is recommended for

use to reduce insertions when operators speak infrequently used words, such as pass assignment,
repick skips, and short product. However, it may also be used to increase the likelihood of accept-
ance for some words.



The default sensitivity threshold is O. You can set this parameter to achieve the appropriate bal-
ance in recognizer sensitivity for specific words based on your application workflow:

« Increasing the sensitivity reduces insertions by requiring the recognizer to be more con-
fident of what the user spoke. This makes the recognizer more likely to accept the cor-
rect word and ignore an incorrect word.

« Decreasing the sensitivity reduces repeating by enabling the recognizer to accept a
word with less confidence thus reducing the likelihood the operator may need to repeat
words. Decreasing sensitivity, however, may increase insertions and is typically not
recommended.

=| Note: When set, this parameter overrides the previously released BlueStreak_Decode_Sens-
"~ itivity parameter, which sets a global threshold for sensitivity.

For example, to reduce insertions of the infrequently used vocabulary word "sign off," set the para-
meter BlueStreak_Decode_Sensitivity_sign_off=2 to increase the sensitivity of "sign off." When an
operator speaks "sign off," the recognizer will only accept the word and move on with the task if it
has a higher level of confidence the operator actually spoke "sign off."

Vocollect recommends setting the threshold between 1.5 and 2 for infrequently used vocabulary
words. This setting eliminates most insertions of the word while only having a minor impact to
rejecting words that should have otherwise been accepted thus creating a balance of per-
formance. A setting higher than 3 is likely to cause significant repeating and is not recommended.
This parameter should be set within the default task package or added to the task package during
implementation.

Note: To further reduce insertions and repeating of specific words, the number of discrete repe-
titions during enrollment training can be increased to improve performance with a better

voice template. The more times a word is trained, the more likely the recognizer will accept it
when first spoken or ignore it due to other noises. To increase the number of iterations of a
word during enrollment training, either modify the Embedded Training within the task pack-
age in VoiceConsole or update VoiceApplication settings within VoiceArtisan adding an addi-
tional row for each new iteration the operator should train of that word. In addition, for
particularly problematic words, the operator may always retrain a word via the menu options
to force a retrain with 10 iterations.

=

Ability to Obtain Task Configuration

With this release, we added an API, get task configuration (), which returns the config.xml
file in the task package in a DOM tree structure. See the VoiceCatalyst Emulator online help for

more information.
Rebuild the Last Prompt Spoken

When a user says "say again” or the application transitions from "sleep” to "on", the text that is
spoken is the last TTS string that the application generated. The new APIs allow you to modify
this remembered text or control whether a generated prompt will be remembered in the
lastPrompt variable.

get_last_prompt(Q)
Returns the last prompt spoken string value

set_last_prompt(prompt_string)



Set last prompt spoken string value

See the VoiceCatalyst Emulator online help for more information.

"Say Again" Processed by Voice Application
With this release, if you add "say again” as a vocabulary item on a vocabulary link, it will be recog-

nized and processed by the voice application.

Callback For Any Callable Object

A new API, set_event callback(generic callback, eventType), was added. You can now
register a callback function for existing event types as well as the following new event types:

o Operator Load
« Device Sleep

« Device Wake up
o Locale Change

The voice API has also enumerated all supported event types. The enumerations begin with EVT ,
for example, voice .EVT OPERATOR LOAD CB for the operator load event.

Vocollect VoiceArtisan® Release Notes: Featuresin 1.3.1

Updates to Support VoiceCatalyst 2.1

This version of VoiceArtisan contains updates to support the development of applications on
VoiceCatalyst 2.1. To support Croatian and Serbian TTSs, the Phonetics tab of the Voice Con-
figuration Editor includes these two languages in the language drop down lists.

Vocollect VoiceArtisan® Release Notes: Features in 1.3.0

Add Vocabulary from Python Code

If you typed a new vocabulary item into Python code, you would also need to add it to the Vocab-
ulary tab in the Voice Configuration Editor. You can now add vocabulary in a Python file directly
to the project's vocabulary. For more information, see ../tasks/add_vocab_python.htm in the
online help.

Record and Playback for Creating Personal Voices

Vocollect Personal Voices are high-definition human voices that are an alternative to the stand-
ard text-to-speech voices. Personal Voices can be created in VoiceArtisan through the record and
playback functions.

The Voice Configuration Editor now has a Record/Playback tab that lets you enter any recorded
audio files and the phrases they represent. You have the option to extract phrases from an exist-
ing properties file.

When the distributable file is created, these files will be transformed into the Vocollect Audio File
format and compressed.



Map Responses in Mock Catalyst

Mock Catalyst lets you type rather than speak responses to prompts. If you want to type different
vocabulary items in response to prompts than those defined in the task, you can now map vocab-
ulary items to words you would prefer.

Library Dependencies

With this release, if you are extracting a VoiceArtisan application project to your workspace, you
will be notified if libraries on which that application are dependent are not installed.

User Interface Enhancements

The Phonetics tab of the Voice Configuration editor has been updated to let you remove a phrase
from a single locale or from all locales by pressing buttons at the bottom of the tab.

The VoiceArtisan Libraries view can now be sorted by any of the visible columns by clicking the
header of the column by which you want to sort.

Fixes and Enhancements in 1.3.0

VoiceArtisan Fixes

UTF-8 Characters Read Properly

In the previous release, if your test file referenced a LUT response VSCVAIDE-25
data file containing UTF-8 characters, it would not be read with the
proper encoding. This has been fixed.

Correct "No Log Selected" Message Displays

Previously, if you attempted to create a script from the Voice Logs
view, or if you tried to generate LUTs from that view, but no log file VSCVAIDE-40
was selected, you would incorrectly receive a message prompting you
to select a VCE instance. This message now correctly reads: No log
file(s) selected.

Test Script Confirmation Now Correct

In the previous release, when you generated a script from a log file in
the Voice Logs view, when the script was generated, the confirmation |ygcyaAIDE-32
message would incorrectly read: Don't show this message again. This
has been fixed; the message now reads: log_test.py generated suc-
cessfully.

Project Name Mismatch No Longer Occurs

In the previous release, if the name of the project extracted into your
workspace did not match the project name defined in the .project file
and you ran Python unit tests, you would receive a key error. This has
been fixed.

VSCVAIDE-33

Progress Reported When Adding Library VSCVAIDE-34




When you are adding a library to your VoiceArtisan workspace from
the Libraries view, a progress bar is now displayed while the library is
being added.

Featuresin 1.2.0

Support for Eclipse 3.7

You can now use Eclipse version 3.7 with the VoiceArtisan plug-in.

Support for PyDev 2.6
With this release, support for PyDev 2.6 has been added.

Important: We have released new versions of VoiceCatalyst Emulator 1.0.0, 1.0.1, and 1.1.0 with
the dependency on PyDev removed. If you want to upgrade to PyDev 2.6 and already have
VoiceCatalyst Emulator installed, do one of the following:

o Install or upgrade the VoiceCatalyst Emulator versions before upgrading VoiceArtisan

« Uninstall the VoiceCatalyst Emulators, upgrade VoiceArtisan, then reinstall the
VoiceCatalyst Emulator versions.

Import .zip Files into Voice Logs View

With this release, you can import compressed (.zip) log files into the Voice Logs view in addition
to clear text files.

Full Method in Tooltip

Previously, when you hovered over a conditional link, a tooltip would appear, displaying the name
of the method associated with the link. With this release, the tooltip also displays the method's
code.

Alternate Methods For Changing Plug-in to Project

Now you can do one of these in the VoiceArtisan Libraries view to extract a project from a down-
loaded plug-in library, voice application or example:

o Double-click on the plug-in

o Right-click on the plug-in and select Add as Project
These methods are in addition to the VoiceArtisan Libraries view's drop-down menu and the Add
as Project toolbar button that existed in previous versions.
Priority Prompts in Output

When you run MockCatalyst, the output in the Console view will now display <pp> at the end of
priority prompts.



System Requirements for the VoiceArtisan Bundle

Operating Systems
« Windows 7 Professional 64-bit
« Windows 10 Professional 64-bit

Hardware
To test a voice application on your computer, you will need a Vocollect wired headset.

We recommend you use a CMedia CM108 USB Virtual 7.1 Channel Sound Adapter for your head-
set. This adapter has been tested by Honeywell and is recommended for testing applications
through VoiceCatalyst Emulator.

Software

Eclipse version 4.7.3a

provided in zip file

PyDev 6.2.0

provided in zip file

Java version 8 or higher

not provided--you must supply

must be a 64-bit version to be compatible with Eclipse

Fixes and Enhancements in 1.2.0

VoiceArtisan Fixes

In the previous release, you were unable to enter UTF-8 encoded char-
acters into the Console view. This has been fixed. UTF-8 encoded RBIRD-412
characters are now accepted.

In the previous release, you were unable to import all of an operator's
templates from VoiceConsole version 4.1. This has been fixed; you

. . VSCVAIDE-4
can now import templates from or export templates to VoiceConsole
400r 4.1 (HTTP only) or 4.2 (HTTP or HTTPS).

Core Library Fixes

In the previous release, scanned data were not being cleared from the

buffer, causing errors. This has been fixed. RBIRD-407

The default timeout for digits has been changed from .600 ms to .700
ms. The default timeout for alphas and alphanumeric entries has been | RBIRD-392
changed from .700 to .800 ms.

Il'n the prgwous releasg, prompt digits required was prone to inser RBIRD408
tions. This has been fixed.




LUT/O0DR Library Fixes

Fixed an issue that would cause the LED to be solid red and would cause the
device to reboot.

PyDev Fixes

In the previous release, setting a break point and running a voice application in
debug mode would VSCVAIDE-9 cause an error when opening the file. This has
been fixed in PyDev 2.6. For a full list of fixes in PyDev 2.6, see http://py-

dev.org/

Featuresin 1.1.0

VoiceLink Voice Application Now a Plugin

The VoiceLink application source can now be installed as an Eclipse plugin. Note that you must
obtain a new license with the VoicelLink feature enabled to download this project. In addition, you
must install VoiceArtisan 1.1.0 before attempting to download the VoiceLink voice application, or
the download will fail.

Project Selection in Export Wizard

If you didn't select a project before attempting to create a distributable file, the Export wizard will
display a page containing a list of all VoiceArtisan projects in your workspace. You can select the
project to export at this point.

Wizard for Creating TaskBase Classes

The New wizard now has an option for creating an extension to the TaskBase class in the Core
Library. The wizard lets you enter parameters and states that are then incorporated into the gen-
erated script. For more information, see the online help.

Specify Version of VoiceCatalyst Emulator When Creating New Project

You can now select which installed version of VoiceCatalyst Emulator you want to use for a par-
ticular project in the New Project wizard.

Note that you can always change the version you are using for a given project in the project's
properties or in the run configurations.

Anchor Words for Digit Prompts

Currently, if the max_length parameter in a prompt is set to None, an anchor word (for example,
"ready") is required. With this release, setting min_length or max_length to None causes an anchor
word to be required. Setting max_length to None will also disable the timeout.

Selected Filters Appear in Voice Device View

The filters you select to use for the Voice Device view will now appear in a pane to the right of the
Voice Device view.


http://pydev.org/
http://pydev.org/

Changes to the Project Properties Tab in the Voice Configuration Editor

Project properties are now inherited from referenced projects. We updated the Project Properties
tab of the Voice Configuration Editor to indicate which properties came from your current project
and which ones are inherited from referenced projects.

We also revised the user interface to make it easier to add properties and you can now search for
a selected property in the source code.

Fixes and Enhancements in 1.1.0

VoiceArtisan Fixes

When you export a VoiceArtisan voice application, the process will no longer compile
Python files. That is, the files in the voice application distributable will have a .py
rather than .pyc extension. This will allow you to upgrade to a newer version of Python
while maintaining compatibility with older versions.

Note that if you use VoiceArtisan 1.1 and build the application for a 1.0 version of
VoiceCatalyst and you select Unprotected, the Python files will be uncompiled.

In the previous release, special characters in XML data generated from log files were

gSBéRD_ not being properly encoded, so the LUT/ODR Server was unable to properly parse the
data. This has been fixed; special characters are now encoded properly.
RBIRD- | In the Voice Logs view, Python script generated from log files included invalid vocab-
374 ulary for responses. Invalid responses are now ignored.
VoiceArtisan will now run on a 64-bit platform (Windows 7). To run the Eclipse version
we provide, you will need to install a 32-bit version of the Java Runtime Environment.
Previously, the LUT Data File Generator in the Voice Logs view would misinterpret cer-
RBIRD- . . . L . .
378 tain data in the log file, causing it to create incorrect LUT responses. This has been
fixed.
RBIRD- | Previously, the LUT Data File Generator in the Voice Logs view would create responses
372 to ODRs. This has been fixed.
In the previous release, VoiceArtisan would terminate unexpectedly while debugging a
RBIRD- | voice application with multiple threads. This is an issue with the PyDev plugin that
364 requires editing the PyDev code to work around the issue. This has now been fixed in
the base VoiceArtisanEclipse.zip.
In the previous release, the Voice Device view did not display the help message at the
pick prompt even when the view was properly filtered to do so. This has been fixed.
If a project references a library with an different version of VoiceCatalsyt Emulator and
the two versions of VoiceCatalyst Emulator are potentially incompatible, you will
receive a warning.
With this release, if you delete templates from the Operator view in VoiceArtisan, the
RBIRD- | same template will be removed from its location in VoiceCatalyst Emulator so that you
376 will be forced to retrain the template. In previous releases, you had to delete the tem-

plate in both locations.




You will now receive a warning if a word you enter in the Embedded Training tab of the
VoiceConfiguration Editor is not currently in the project's vocabulary items.

VoiceCatalyst Emulator Fixes

With this release, if you delete templates from the Operator view in VoiceArtisan, the
RBIRD- | same template will be removed from its location in VoiceCatalyst Emulator so that you
376 will be forced to retrain the template. In previous releases, you had to delete the tem-
plate in both locations.

In the previous release of MockCatalyst, if you returned from a global word to a node

RBIRD-

391 with a prompt, the prompt would not be spoken. This has been fixed; the prompt will
now be spoken.

RBIRD- With this release of MockCatalyst, if you use the open vad resources function and

356 the file is not found, an I0Error will be thrown just as it is when running VoiceCatalyst

on a device.

General Library Fixes

RBIRD- | With this release, each library has a uniquely named unit test package. This prevents
386 conflicts caused when trying to import several packages with the same name.

Core Library Fixes

RBIRD- | Previously, dialogs. runner did not work across multiple threads. This was fixed by
387 moving the variable to the TaskRunnerBase class.

In the previous release, there could be recognition problems because the speech
RBIRD- | timeout would happen more quickly than it did with tasks developed in TaskBuilder.
392 With this release, BaseDialogs defaults the timeout to 700ms, and the two alpha func-
tions (prompt alpha and prompt alpha numeric) are set to 800ms.

Previously, digit prompts would ignore scans after any digits were spoken or inserted.
With this release, if scanning is done after digits are spoken, the digits are ignored and
only the scan is accepted.

RBIRD-
284

Featuresin 1.0.1

Localization

The VoiceArtisan and VoiceCatalyst Emulator user interfaces and the online help are available in
Japanese.

Copy Vocabulary into Voice Configuration Editor Phonetics Tab

With this release, you can copy all vocabulary added to a voice application into the Phonetics tab
of the Voice Configuration Editor, so you don't have to enter each word into the phonetics user
interface.



Enter Multiple Phonetic Substitutions for a Phrase

The Phonetic Words tab in the Voice Configuration editor was redesigned. You can now add a
phrase and enter phonetic substitutions for that phrase in all languages you want your voice
application to support.

Headless Build

You can now build VoiceArtisan voice applications using command line arguments or Ant. For
more information, see the online help.

Export an Application Package for Testing

With this release, you can export a project as a Mock Catalyst archive file that can be tested
without a Talkman® device or the VoiceArtisan IDE. This may be helpful for testing a voice applic-
ation against a WMS vendor's system.

New Device Support

With this release A500 joins T5 and T5m in supporting the Vehicle Mount configuration. A500
devices can now be mounted to a vehicle, such as a forklift or pallet jack, and use the vehicle's
battery to power the device.

See Vocollect's Hardware Documentation for more information.

Plugin Release Notes

We have now included release notes for each of the plugins, so you can determine beforehand
whether you want to download the update.

To access the release notes, in the Available Updates dialog box, select the plugin. In the Details
section, click the More... link and select General Information.
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